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Multi-Lane @
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Welcome to the TekExpress® 10G-KR Transmitter Automated Solution
application. This application provides an automated, simple, and efficient way to
test the 10G-KR transmitter interfaces and devices consistent to the requirements
of the IEEE 802.3ap-2007 specification.

TekExpress 10G-KR Key features and benefits

®m  Automates compliance measurements for [EEE 802.3ap-2007 specifications
= Automated test setup for measuring transmitter equalization levels

m  Provides automation solution for compliance and DPOJET for debug

m  Shorter testing time

= Minimizes the user intervention during test execution

m  Provision for entering filter files to de-embed the effects of backplane traces
and any other components in the signal pathway

m  Performs fully-automated testing for transmitter measurements

m Individual test selection or test groups in the tree-structure
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Built-in reporting features
= Provides a Pass/Fail summary table
m  Provides margin details on each test

m  Provides plots for measurements, with enhanced view of measurement
results and waveforms

= Provides a consolidated report for all tests

Complete programmatic interface enables automation scripts to call 10G-KR
functions
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Conventions

This help uses the following conventions:

®m  The term "Application" and "Software" refers to the TekExpress 10G-KR
Solution application.

®  The term “DUT” is an abbreviation for Device Under Test.

= The term “select” is a generic term that applies to the different methods of
choosing a screen item (button, control, list item): using a mouse or using the
touch screen.

Table 1: Icon descriptions

Icon Meaning

o This icon identifies important information.

This icon identifies conditions or practices that could result in loss
of data.
@ This icon identifies additional information that will help you use
the application more efficiently.

TekExpress® 10G-KR Printable Application Help 1
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Related documentation

The following documentation is available as part of the TekExpress® 10G-KR
Solution application.

Table 2: Product documentation

Item Purpose Location

Help Application operation
and User Interface help

PDF of the help Printable version of the _
compiled help =TT M

PDF file that ships with 10G-KR Solution
software distribution (TekExpress 10G-KR-
Automated-Test-Solution-Software-Printable-
Help-EN-US.pdf).

You can download the PDF version of the
manual from the Tektronix website.
www.tek.com

See also:  Technical support

Technical support

Tektronix values your feedback on our products. To help us serve you better,
please send us your suggestions, ideas, or comments on your application or
oscilloscope. Contact Tektronix through mail, telephone, or the website.

When you contact Tektronix Technical Support, please include the following
information (be as specific as possible):
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General information All instrument model numbers

= Hardware options, if any
= Probes used
= Your name, company, mailing address, phone number, FAX number

m  Please indicate if you would like to be contacted by Tektronix about your
suggestion or comments.

Software version number

Application specific

information Description of the problem such that technical support can duplicate the

problem

m Ifpossible, save the setup files for all the instruments used and the
application

m  Ifpossible, save the TekExpress setup files, log.xml, *.TekX (session files
and folders), and status messages text file

m Ifpossible, save the waveform on which you are performing the
measurement as a .wfm file

TekExpress® 10G-KR Printable Application Help 3
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Minimum system requirements

The following table shows the minimum system requirements to install and run
the TekExpress 10G-KR application.

Table 3: System requirements

Component Description

Oscilloscope = Tektronix DPO70K, DX/SX series oscilloscope with bandwidth
>=16 GHz
= Firmware Version: 10.8 or above

= Opt. DJA and DJAN

Software = [ronPython 2.7.3 installed

= PyVisa 1.0.0.25 installed
= Microsoft NET 4.0 Framework

= Microsoft Internet Explorer 7.0 SP1 or greater, or other Web browser,
for viewing reports

= Adobe Reader software 7.0 or greater for viewing portable
document format (PDF) files

TekExpress® 10G-KR Printable Application Help 5
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Instruments and accessories required

TekExpress 10G-KR application is launched on DPO70K series oscilloscope.
The following table lists the instruments and accessories required for this
application.

Table 4: Instruments and accessories required for 10G-KR application

Instrument/Accessory Model number Quantity

Oscilloscope DPO/DSA/MSO71604C, DPO/
DSA/MS072004C, DPO/
DSA72504D, DPO/
DSA73304D, DPO/
MSQ72304DX, DPO/
MSQ72504DX, DPO/
MSQO73304DX, DPO77002SX,
DPO75002SX, DPO73304SX,

—_

and DPO75902SX

Cables A pair of matched SMA cables |2
(TCA-SMA connector)

Fixtures N.A.

The signal is tapped directly
from the source using the
single-ended cables or
differential probes

DC Blocks PSPL5501A DC Block 2

Probes P7516, P7520, P7520A, P7716,| one per lane
P7720, and P7633
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Downloading and installing the software

Complete the following steps to download and install the latest 10G-KR
application. See Minimum system requirements for compatibility.

1. Go to www.tek.com.

2. Click Downloads. In the Downloads menu, select DOWNLOAD TYPE as
Software and enter /0G-KR in the MODEL OR KEYWORD field and click
SEARCH.

L. Downloads

Download Manuals, Dat: d more

DOWNLOAD TYPE MODEL OR KEYWORD

e

3. Select the latest version of software and follow the instructions to download.
Copy the executable file to the oscilloscope.

4. Double-click the executable and follow the on-screen instructions. The
software is installed at C:\Program Files\Tektronix\TekExpress\10G-KR\.

5. Select Analyze > 10G-KR from the TekScope menu to Launch the
application.

View software version

Use the following instructions to view the version information and the
application modules such as the Programmatic Interface and Programmatic
Interface Client.

To view version information for TekExpress 10G-KR, click i& button in the
TekExpress application and select About TekExpress.

\gi About Tektronix TekExpress 10G-KR

ekExpress

Automated Solutions

NOTE. This example shows a typical version details dialog box, and may not
reflect the actual values as shown when you open this item in the application.

TekExpress® 10G-KR Printable Application Help 7



Getting started

Application directories

See also

The TekExpress 10G-KR application files are installed at the following location:

C:\Program Files\Tektronix\TekExpress\TekExpress 10G-KR

. Bin

. Compliance Suites
, Examples

, ICP

| Images

J Lib

. Report Generator

| Tools

The following table lists the application directory names and their purpose:

Table 5: Application directories and usage

Directory names

Usage

Bin

Contains application libraries

Compliance Suites

Contains compliance-specific files

Examples Contains various support files

ICP Contains instrument and application-specific interface libraries
Images Contains application images

Lib Contains application utility files

Report Generator

Contains style sheets for report generation

Tools

Contains instrument and application-specific files

View test-related files

File name extensions

TekExpress® 10G-KR Printable Application Help
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File name extensions

This application uses the following file name extensions:

File name extension

Description

.TekX

Application session files (the extensions may not be displayed)

Py

Python sequence file

xml

Test-specific configuration information (encrypted) files
Application log files

.Csv

Test result reports
Plot data

.mht

Test result reports (default)
Test reports can also be saved in HTML format

.pdf

Test result reports
Application help document

xslt

Style sheet used to generate reports

Seealso  View test-related files

Application directories

TekExpress® 10G-KR Printable Application Help
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Launch the application

To launch the TekExpress 10G-KR application, select Analyze > TekExpress
10G-KR from the TekScope menu.

|1 DuT DUTID DUTOO G

= Acguire live waveforms Use pre-recorded waveform files

/| Test Selection

Acquisitions Device Profile

Source

Configuration
B Preferences

+ Single Ended Differential

Multi-Lane @

Selected Lanes
Lanel

When you launch the application for the first time, the file C:\Users\<username>
\Documents\My TekExpress\TekExpress 10G-KR\Resources.xml is mapped to
drive X:. This file contains information about available network-connected
instruments. The session files are stored in X:\10G-KR\. If this file is not found,
then the application runs Instrument Discovery Program to detect the network-
connected instruments before launching 10G-KR solution.

If the application is behind the oscilloscope application, click Analyze > 10G-
KR to bring it to the front. To keep the 10G-KR application window on top,
select Keep On Top from the 10G-KR Options menu.

TekExpress® 10G-KR Printable Application Help 11
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See also:

Application controls

Applications panel overview

Application panels overview

12

TekExpress 10G-KR application uses panels to group Configuration, Results, and
Reports settings. Click any button to open the associated panel. A panel may
have one or more tabs that list the selections available in that panel. Controls in a
tab can change depending on the settings made in the same tab or another tab.

DUTID DUTO0! @

@ Acguire live waveforms O Use pre-recorded waveform files

Device Prafile
Source

'+ Zingle Ended | Differertial

Multi-Lane i

Selected Lanes
Laneld
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Table 6: Application panels overview

Panel Name

Purpose

Setup panel

Use to select the test setup controls which are grouped in tabs. The
controls in a tab can change depending on settings made in the same tab
or another tab. Click Setup to open this panel.

Use this panel to:

= Setthe DUT parameters

= Select tests

= set acquisition parameters

= set configuration parameters

= set preferences parameters

Status panel

This panel displays the acquisition status and analysis status for the
selected tests in Test Status and logs in Log View.

Results panel

This tab displays the summary of test results and allows you to select the
result viewing preferences.

Reports panel

Browse for reports, save reports as specific file types, specify report
naming conventions, replace current test results in the report with the test
result(s) of previous run in current session, select report content to
include (summary information, detailed information, user comments,
setup configuration, application configuration), and select report viewing
options.

See also:  Application controls

TekExpress® 10G-KR Printable Application Help
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Global application controls

14

Application controls

Table 7: Application controls descriptions

Stop

R~

Item Description

Options menu Menu to display global application controls.

Panel buttons Controls that open panels for configuring test settings and
options.

Start / Stop button Use the Start button to start the test run of the measurements in
the selected order. If prior acquired measurements have not
been cleared, the new measurements are added to the existing

Start set.

The button toggles to the Stop mode while tests are running. Use
the Stop button to abort the test.

Pause / Continue button

Pause

Continue

Use the Pause button to temporarily interrupt the current
acquisition. When a test is paused, the button name changes to
“Continue.”

TekExpress® 10G-KR Printable Application Help
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Item

Description

Clear button

Clear

Use Clear button to clear all the existing measurement results.
Adding or deleting a measurement, or changing a configuration
parameter of an existing measurement also clears
measurements. This is to prevent the accumulation of
measurement statistics or sets of statistics that are not coherent.
This button is available only on the Results panel.

Minimize button

&

Minimizes the application.

Close button

Exits the application.

Application window move

Place the cursor over the application window and drag it to the
desired location.

Mini view / Normal view

Toggles the application between mini view and normal view.
Mini view displays the run messages with the time stamp,
progress bar, Start / Stop button, and Pause / Continue button.
The application automatically moves to the mini view when you
click the Start button.

- /. TekExpress 106-KR - (Untitl

02/19/18 15:11:22 : Analyzing Differential peak-peak output voltage (mas] with Ty disabled test
02/13/19 15:11:22 : Analyzing for Maximum differential peak-peak max cutput vohage, Tx disabled [
02/13/18 15-11:22  Waveform retrieved for Differential peak-peak output voltage (mas) with Tx dise
02/19/18 15:11:23: Populating results for Differertial peak-peak output voltage [max) with Tx disabl
02/19/18 15:11:23 : Compare limit 0 GELE (>= <= 30 for Yalue = 7 600001 e+00 Result Pass
02/19/18 15:11:23 : Saving the acquired wavefrom list to the P/
02/19/18 15:11:23: Overal Execution Time: 00040
Pause

e — T

TekExpress® 10G-KR Printable Application Help
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Options menu overview

To access Options menu, click i in the upper-right corner of the application. It
has the following:

Options menu

Default Test Setup
Open Test Setup
Save Test Setup
Save Test Setup As

Open Recent

Instrument Control Settings
Keep On Top
Email Settings

16

Deskew. ..

Help

About TekExpress

Menu

Function

Default Test Setup

Opens an untitled test setup with the following default configuration:
Acquire Live Waveforms

DUT Type: 10GBase-KR

Source: Single Ended

Open Test Setup Opens a saved test setup.
Save Test Setup Saves the current test setup.
Save Test Setup As | Saves the current test setup with a different file name or file type.

Open Recent

Displays the recently opened test setups to open

Instrument Control Detects, lists, and refreshes the connected instruments found on

Settings specified connections (LAN, GPIB, USB, and so on).

Keep On Top Keeps the application on top of all the application.

Email Settings Use to configure email options for test run and results notifications.

Deskew Allows to read the skew and attenuation values from the TekScope
application. Before using this option, manually compensate for skew and
attenuations in Tekscope application.

Help Displays the application help.

About TekExpress

= Displays application details such as software name, version number,

and copyright
= Provides a link to the end-user license agreement

= Provides a link to the Tektronix website

TekExpress® 10G-KR Printable Application Help
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See also:. Application controls

TekExpress instrument ~ Use TekExpress Instrument Control Settings dialog box to search the instruments
control settings  (resources) connected to the application. You can use the Search Criteria to
search the connected instruments depending on the connection type. The details
of the connected instrument is displayed in the Retrieved Instruments window.

You can access this dialog box from the Options menu.

X
_TekExpress Instrument Control Se

May 12, 2017 21:00:39

The connected instruments displayed here can be selected under Global settings
in the Configuration tab.

NOTE. Select GPIB (Default) when using TekExpress 10G-KR application.

See also:. Options menu overview

TekExpress® 10G-KR Printable Application Help 17
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View connected
instruments

Use the Instrument Control Settings dialog box to view or search for connected
instruments required for the tests. This application uses TekVISA to discover the
connected instruments.

To refresh the list of connected instruments:

1.
2.

3.

4.

From the Options menu, select Instrument Control Settings.

In the Search Criteria section of the Instrument Control Settings dialog box,
select the connection types of the instruments for which to search.

Instrument search is based on the VISA layer, but different connections
determine the resource type, such as LAN, GPIB, and USB. For example, if
you choose LAN, the search will include all the instruments supported by
TekExpress that are communicating over the LAN. If the search does not find
any instruments that match a selected resource type, a message appears
telling you that no such instruments were found.

Click Refresh. TekExpress searches for connected instruments.

After discovery, the dialog box lists the instrument-related details based on
the search criteria you selected. For example, if you selected LAN and GPIB
as the search criteria, the application checks for the availability of
instruments over LAN, then GPIB.

_TekExpress Instrument Control Se :'

May 12. 2017 21:00:39 —

The details of the instruments are displayed in the Retrieved Instruments table.
The time and date of instrument refresh is displayed in the Last Updated field.

TekExpress® 10G-KR Printable Application Help
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See also:. Configuration test parameters

Equipment connection diagram

Configure email settings  To be notified by email when a test completes, fails, or produces an error,
configure the email settings.

1. Click Options > Email Settings to open the Email Settings dialog box.

2. (Required) For Recipient email Address(es), enter one or more email
addresses to which to send the test notification. To include multiple
addresses, separate the addresses with commas.

3. (Required) For Sender’s Address, enter the email address used by the
instrument. This address consists of the instrument name followed by an
underscore followed by the instrument serial number, then the @ symbol and
the email server used. For example:
DPO72016C_B130099@yourcompany.com.

4. (Required) In the Server Configuration section, type the SMTP Server
address of the Mail server configured at the client location, and the SMTP
Port number, in the corresponding fields.

Enter a valid login name and password in the corresponding fields. Select
Enable SSL, if the server requires SSL/TLS technology.

NOTE. If any of the above required fields are left blank, the settings will not
be saved and email notifications will not be sent.

5. In the Email Attachments section, select from the following options:
= Reports: Select to receive the test report with the notification email.

= Status Log: Select to receive the test status log with the notification
email. If you select this option, then also select whether you want to
receive the full log or just the last 20 lines.

6. In the Email Configuration section:
= Select the message file format to send: HTML (the default) or plain text.

= Enter a maximum file size for the email message. Messages with
attachments larger than this limit will not be sent. The default is 5 MB.

= Enter the number in the Number of Attempts to Send field, to limit the
number of attempts that the system makes to send a notification. The
default is 1. You can also specify a timeout period.

7. Select the Email Test Results When complete or on error check box. Use
this check box to quickly enable or disable email notifications.

8. To test your email settings, click Test Email.
9. To apply your settings, click Apply.
10. Click Close when finished.
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Setup panel

Setup panel overview

20

Email settings

The Setup panel contains sequentially ordered tabs that helps you guide through
the test setup and execution process.

DUTID DUTO0! @

@Acquire live waveforms O Use pre-recorded waveform files
Device Profile

Source

() gingle Ended | Differential

Multi-Lane é

Selected Lanes
Laned
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Set DUT parameters ~ Use the DUT tab to select parameters for the device under test. These settings are
global and apply to all tests of current session. DUT settings also affect the list of
available tests in the Test Selection tab.

. TekExpress 10G-KR - (Untitle

]
m @ ouT DUTID DUTOM @

+ ) Acguire live waveforms Use pre-recorded waveform files

| Test Selection
/| Acquisitions Device Prafile

Source

Configuration
B Preferences

) Single Ended Differential

Multi-Lane @

Selected Lanes
Laned

Click Setup > DUT to access the DUT parameters:

Table 8: DUT tab settings

Setting Description

DUT ID Adds an optional text label for the DUT to reports. The default
value is DUT001. The maximum number of characters is 32.
You cannot use the following characters in an ID name: (.,..,...,
\[77<>])

@ Opens Comments dialog box to enter text to add to the report.
Comments icon (to the | Maximum size is 256 characters. To enable or disable comments

right of the DUT ID field) appearing on the test report, see Select report options.

Acquire live waveforms Acquire active signals from the DUT for measurement and
analysis.

Use pre-recorded waveform Run tests on a saved waveform. Select Options > Open Test

files Setup to recall a saved test setup.

Source

= Single Ended - Source as single-ended signals

= Differential - Source as differential signal

Multi-Lane Multilane is supported using available channels on the
oscilloscope (max of two lanes for single-ended, four lanes for
differential connections).
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See also:. Select tests

Select tests  Use the Test Selection tab to select the tests. The test measurements available
depends on the standards selected in the DUT tab.

./ TekExpress 10G-KR - 5 @eo
q ouT Transmitter : TPOa : [EEEBD2.3, Section 72.7.1

@ Test Selection ={] 100-kR

-] Signaling speed

Acquisitions Differential peak-to-peak output voltage (max)

Differential peak-peak output voltage {max) with Tx dizabled

Configuration Transition time
Wa output jitter (neak-peak)

C{13 Inerement
Coefficient update - C(1) Decrement
Coefficient update - C{0) Increment
Coeficient update - G(0) Decrement
Coeficient update - GC1) Increment
~ | Coefiicient update - C{-1) Decrement

[N s [T OO 4 mboden

Test Description

Please gelectatestname to view its
description

Table 9: Test Selection tab settings

Setting Description

Tests Select or deselect a test.

Test Description Shows brief description for the selected test.

Deselect All Click to deselect all tests.

Select Al Click to select all tests. By default, all tests are selected.

Schematic Click to display the schematic diagram of the DUT test setup for
the selected test. Use the diagram to verify the test setup before
running the test.

See also:. Set acquisition tab parameters
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Set acquisition tab ~ Use the Acquisitions tab to view the test acquisition parameters. The contents
parameters displayed on this tab depends on the settings in the DUT tab and Test Selection
tab.

_v-'gTekExpress 10G-KR - (U Ly ] @00

-./ ouT Spec: 10G Base-KR-IEEE 802.3ap, 10G Base-KR4-IEEE 802.3ba

TestMame Acguisition
Tioeh Selleing » Differential peak-to-peak outputwaltage Lane0 : 1010 Square pattern
Differential peak-peak outputvoltage (m Lane0 : Tw-disabled
Transition time Laned : M1M0 Square pattern

 Results ) @ Acquisitions
Configuration

Preferences

Acguisition and Save Options
All Waveforms are saved before analysis

[ Show Acuire Pararmetars

Signal Yalidation

Prompt me if Signal... n

Completed

NOTE. 10G-KR application acquires all waveforms required by each test group
before performing the analysis.

Table 10: Acquisitions tab settings

Setting Description

Acquisition and Save Options | All waveforms are saved before analysis.

Show Acquire Parameters Select to view the acquisition parameters.

Signal Validation Sets the application to validate acquisition signals and perform

the specified action to take when acquired signals do not meet
the requirements. Select the action from the list.

TekExpress 10G-KR saves all acquisition waveforms to files by default. The
waveforms are saved in a unique folder for each session (a session is started
when you click the Start button). The folder path is X:\10G-KR\Untitled Session
\<dutid>\<date> <time>. The images created for each analysis, CSV files with
result values, reports, and other information specific to that particular execution
are also saved in this folder.
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Set configuration tab
parameters

Saving a session moves the session file contents from the Untitled Session folder
to the specified folder name, and changes the session name to the specified name.

Use Configuration tab to configure the global settings and test measurement
configurations. The global settings and the measurements with configurations
available in this tab depends on the standards selected in the DUT tab.

Irstruments Detected

Real Time Scope

|_ De-embedding Filter

Completed.

Table 11: Configuration tab settings

Setting Description
Compliance Mode Select compliance mode. By default, Compliance Mode is selected.
User Defined Mode Select user defined mode; you can edit the test parameters in this mode.
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Setting

Description

Limits Editor

Shows the upper and lower limits for the applicable measurement using
different types of comparisons.

In Compliance Mode, use the Limits Editor to view the measurement high
and low limits used for selected tests.

In User Defined Mode, use the Limits Editor to edit the limit settings.

Limits Editor i
Viber i Ethe valies sbad ol High Lt and Lo
A sk a8 e e e wabas s e o
Testiama Dataiy. Compare Smng | Lowlimit Comosee SWnD  HIgh Limit kel
16 Comenan beck Dt Ve T SET 2

o e resse el RO 1

To edit a value, click the respective field and either select from the
displayed list or enter a new value. Use the bottom scroll bar to view all
available fields.

Global Settings

Instruments Detected

Displays the instruments connected to this application. Click the
instrument name to open a list of available (detected) instruments.
Select Options > Instrument Control Settings and click Refresh to
update the instrument list.

NOTE. Verify that the GPIB search criteria (default) is selected in the
Instrument Control Settings.

De-embedding Filter

Select to apply the de-embed filter file. Click Browse and select the de-
embedding filter files (.flt).

For single ended mode, select filter file for Data Positive and Data
Negative.

= Source file name for data Positive.
= Source file name for data Negative.
For Differential mode, select differential file.

= Differential source filter file name

NOTE. Browse option is enabled only when you select Use filter
file for de-embedding.
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Table 12: Measurement settings

Measurements Settings

Signaling speed Acquire Signal Type

Differential peak-to-peak output voltage (max)

Differential peak-peak output voltage (max) with
Tx disabled

Transition time

Duty Cycle Distortion

Transmitter output waveform characteristics

Output waveform coefficient update - C(1)

Output waveform coefficient update - C(0)

Output waveform coefficient update - C(-1)

Output waveform coefficient status

Common-mode voltage limits

Common mode voltage limits-LP!

Max output jitter (peak-peak) Acquire Signal Type
RiDj Target BER (1e-)

Set preferences tab  Use the Preferences tab to set the application action on completion of a
parameters measurement.

BT ) © OO

MNurmber of Runs
[ Acquirerdnalyze each test |1 times

Actions on Test Measurement Failure

|_ On Test Failure, stop and notify me of the failure @

Popup Settings

Configuration

r Auto close Warnings and Informations during Seguencing
Auta close after |10 Seconds

l 5 | Preferences

1—— |_ Auto close Error Messages during Seguencing. Show in Reports

Auto close after |10 Seconds

26 TekExpress® 10G-KR Printable Application Help



Operating basics

Status panel

Status panel overview

Table 13: Preferences tab settings

Setting

‘ Description

Number of Runs

Acquire/Analyze each test <n> times (not
applicable to Custom Tests)

Select to repeat the test run by setting the
number of times. By default, it is selected with
1 run.

Actions on Test Measurement Failure

On Test Failure, stop and notify me of the failure

Select to stop the test run on test failure, and to
get notified via email. By default, it is unselected.
Click Email Settings to configure.

Popup Settings

Auto close Warnings and Informations during
Sequencing
Auto close after <n> Seconds

Select to auto close warnings/informations
during sequencing. Set the Auto close time. By
default, it is not selected.

Auto close Error Messages during Sequencing.
Show in Reports
Auto close after <n> Seconds

Select to auto close Error Messages during
Sequencing. Set the Auto close time. By default,
it is not selected.

The Status panel accesses the Test Status and Log View tabs, which provide

status on test acquisition and analysis (Test Status tab) and a listing of test tasks
performed (Log View tab). The application opens the Test Status tab when you
start a test run. You can select the Test Status or the Log View tab to view these

items while the tests are running.

Log view

TekExpress® 10G-KR Printable Application Help
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Status view

Table 14: Status panel Log View controls

Control Description

Message History Lists all executed test operations and timestamp
information.

Auto Scroll Enables automatic scrolling of the log view as
information is added to the log during the test.

Clear Log Clears all messages from the log view.

Save Saves the log file to a text file. Use the standard

Save File window to navigate to and specify the
folder and file name to which to save the log
text.

See also:. Application panel overview
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Results panel

Results panel overview = When a test execution is complete, the application automatically opens the
Results panel to display the summary of test results.

Differential Maximurm
peak-peak output differential
(#) voltage (mad with @ Pass peak-peak max
T disabled output voltage, Tx
disabled

completed.

See also:. View a report

Application panels overview

View test-related files  Files related to tests are stored in C:\Users\<username>\Documents\My
TekExpress\10G-KR\. Each test setup in this folder has a test setup file and a test
setup folder, both with the test setup name.

The test setup file is preceded by the TekExpress icon and usually has no visible
file name extension.

Inside the test setup folder is another folder named for the DUT ID used in the
test sessions. The default is DUT001.

Inside the DUTO0O01 folder are the session folders and files. Each session also has
a folder and file pair, both named for the test session using the naming

convention (date) (time). Each session file is stored outside its matching session
folder:
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Reports panel

30

Reports panel overview

[C3)20110520_154553
C)20110520_154713
[C)20110520_155111
[C3)20110520_155920
[C)20110520_160103
Vil 20110520_154553
Vi 20110520_154713
Vil 20110520_155111
v 20110520 155920
Vi 20110520_160103

Each session folder contains image files of any plots generated from running the
test session. If you selected to save all waveforms or ran tests using prerecorded
waveform files, these are included here.

The first time you run a new, unsaved session, the session files are stored in the
Untitled Session folder located at ..\My TekExpress\10G-KR\. When you name
and save the session, the files are placed in a folder with the name that you
specify. A copy of the test files stay in the Untitled Session folder until you run a
new test or until you close the 10G-KR application.

See also:. File name extensions

Use the Reports panel to browse for reports, to name and save reports, select test
content to include in reports, and to select report viewing options.
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Web Archive (*.mht;*.mhtml)

MUY

For information on setting up reports, see Select report options. For information

on viewing reports, see View a report.

See also:. Applications panel overview

Select report options  Click the Reports panel to select the test result information to be included in the
report, and the naming conventions to be used for the report. For example, always
provide a unique name to the report or select to have the same name incremented

each time you run a particular test.

Select the report options before running a test or when creating and saving the
test setups. Report settings are included in saved test setups.

In the Reports panel, select from the following report options:

Table 15: Report options

Setting

Description

Report Update Mode

Generate new report

Creates a new report in .mht, .pdf, or .csv file
format.

Append with previous run session

Appends the latest test results to the end of the
current test results report.

Include header in appended reports

Select to include header in appended reports.

TekExpress® 10G-KR Printable Application Help

31



Operating basics

32

Setting

Description

Replace currenttest | In previous run, current
results session

Select to replace current test results in the report
with the test result(s) of previous run in current
session.

In any run, any session

Select to replace current test results in the report
with the test result(s) in selected run session’s

report. Click Q and select the test result of
any other run session from another setup.

Report Creation Settings

Report name

Displays the name and location from which to
open a 10G-KR report. The default location is
\My TekExpress\10G-KR\Untitled Session. The
report file in this folder gets overwritten each
time you run a test unless you specify a unique
name or select to auto-increment the report
name.

To change the report name or location.

Do one of the following:

B Inthe Report Path field, type over the
current folder path and name.

m  Double-click in the Report Path field and
then make selections from the pop-up
keyboard and click Enter button.

Ensure to include the entire folder path, the file
name, and the file extension. For example: C:
Users\<username>\Documents\My TekExpress
10G-KR\DUT001.mht.

NOTE. You cannot set the file location using the
Browse button.

Open an existing report.

Click Browse, locate, and select the report file,
and then click View at the bottom of the panel.

Save as type

Saves a report in the specified file type selected
from the drop-down list.

NOTE. If you select a file type different from the
default, ensure to change the report file name
extension in the Report Name field to match.

Auto increment report name if duplicate

Sets the application to automatically increment
the name of the report file if the application finds
a file with the same name as the one being
generated. For example: DUT001, DUTO002,
DUTO003. This option is enabled by default.

Create report automatically at the end of the run

Creates report at the end of the run.
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View a report

Setting

Description

Contents To Save

Include pass/fail info in details table

Includes pass/fail information in the details table
of the report

Include detailed results

Includes detailed results in the report

Include plot images

Includes plot images in the report

Include setup configuration

Select to include hardware and software
information in the summary box, at the top of the
report. Information includes oscilloscope model
and serial number, oscilloscope firmware
version, and software versions for the
applications used in the measurements.

Include complete application configuration

Include complete application configuration

Include user comments

Select to include any comments about the test
that you or another user has added in the DUT
tab of the Setup panel. Comments are displayed
in the Comments section under the summary
box at the beginning of each report.

View report after generating

Automatically opens the report in default Web
browser when the test execution is complete.
This option is selected by default.

View

Click to view the recent report.

Generate Report

Generates a new report based on the current
analysis results.

Save As

Specify a name for the report.

The application automatically generates a report when the test execution is
complete and displays the report in your default Web browser (unless you had
cleared the View Report After Generating check box in the Reports panel
before running the test). If you cleared this check box, or to view a different test

report, do the following:
1. Click the Reports button.

2. Click the Browse button and locate and select the report file to view.

3. In the Reports panel, click View.

For information on changing the file type, file name, and other report options, see

Select report options.
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Report contents

A report displays detailed results and plots, as set in the Reports panel.

TekExpress 10G-KR
Transmitter(TP0a) Test Report

Tektronix

DUT ID DUT001 Scope Information MSO71604C, B130223
Date/Time 2018-02-19 15:10:43 SPC, FactoryCalibration PASS.PASS
Device Type Transmi DPOJet Version 1006106
TekExpress 10G-KR Version 101226 Scope F/W Version 10,81 Build 37
TekExpress F Version 43040 Channell Probe NA NA
Execution Mode Live

Frobing Type Differential

Compliance Mode True

Overall Test Result Pass

Overall Execution Time 0:00-40

DUT COMMENT: | General comment

Differential peak—peak output veltage (max) with Tx disabled Pass

Measured
Value

Measurement
Details
Maximum
differential
peak-peak
max output
voltage, Tx
disabled
COMMENTS

Lane Iteration

| Test Result | Margin | Low Limit | High Limit Units | Comments

Lane0 1 76 Pass L:76H:224 | O 30 mV, NA

Back to Summary Table

Setup configuration information

The summary box at the beginning of the report lists setup configuration
information. This information includes the oscilloscope model and serial number,
electrical module model, and software version numbers of all associated
applications.

To exclude this information from a report, clear the Include Setup
Configuration check box in the Reports panel before running the test.

User comments

If you had selected to include comments in the test report, any comments you
added in the DUT tab are displayed at the top of the report.

See also:. Results panel overview

View test-related files
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Equipment connection setup

Click Setup > Test Selection > Schematic to view the equipment setup

diagram(s).
Digital Oscilloscope
DuT .
il .
1) s
Nl g | .
P7520 Probe ©

Figure 1: Connection diagram for differential tests

Digital Oscilloscope

DUT

Figure 2: Connection diagram for single-ended tests
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Compensate the signal
path

Deskew

Use the following procedure to compensate the internal signal acquisition path.
Perform this procedure if the ambient temperature has changed more than 5 °C
(9 °F) since you performed the last signal path compensation. Perform the signal
path compensation once a week. Failure to do so may result in the instrument not
meeting warranted performance levels.

1. Power on and wait for the instrument to complete its warm up period before
continuing with this procedure.

Disconnect any probes you have connected to the input channels.
Set the instrument to Menu mode.
Select Instrument Calibration from the Utilities menu.

Note any instructions that appear in the resulting control window.

AR

Click Run SPC to begin the procedure. The procedure may take several
minutes to complete.

7. Verify that the Status changes to Compensated after the procedure is
complete. If the Calibration Status field indicates anything other than
Compensated, see Signal Path Compensation Status for information on the
readout and recommended action.

NOTE. When making measurements at vertical scale settings less than or equal to
5 mV, you should perform the signal path compensation at least once a week.
Failure to do so may result in the instrument not meeting warranted performance
levels at those volts/div settings.

If skew is present between positive and negative channels, then the channels need
to be deskewed before being used for waveform measurements. TekExpress 10G-
KR provides support for channel deskew using the following method:

1. Determine what the skew is for each channel.
2. From the TekScope menu, select Vertical > Deskew.

3. In the Deskew/Attenuation window, click the channel (1 — 4) button for the
first channel to be deskewed.

4. Click in the Ch(x) Deskew Time entry field and enter the skew. The skew
can be +ve or —ve.

5. Click the channel button for the next channel and repeat step 4.

6. After entering the skew for all the channels that require it, from the Options
menu in TekExpress 10G-KR, select Deskew.
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7. Inthe Deskew and Attenuation dialog box, select the desired level:

= Less than 100 mV signal amplitude: Select this if the signal amplitude is
such that the oscilloscope’s vertical setting is less than 100 mV/division.

= 100 mV or greater signal amplitude: Select this if the signal amplitude is
such that the oscilloscope’s vertical setting is greater than 100 mV/
division.

X
—Deskew and Attenuati

Figure 3: Deskew
8. Click Set on Scope to set the deskew and attenuation values on oscilloscope.

9. Click Read from Scope to read the deskew and attenuation values from the
oscilloscope.

10. Click View values to view the deskew, attenuation, and bandwidth values.

11. When the status in the dialog box indicates the deskew is finished, click
Close.

_Deskew I Attenuation f Band

SCF ]
Deskew: Current 0.000000 0.000000 0.000000 0, 000000
Deskew: Stared 0.000000 0.000000 0.000000 0, 000000

Attenuation: Current 0.0 0.0 0.0 0.0
Attenuation: Stored 0.0 0.0 0.0 0.0
Bandwidth: Current  16.0000E49 16.0000E+9 16.0000E+9 16.0000E+9
Bandwidth: Stored 16.0000E+9 16.0000E+9 16.0000E+9 16.0000E+9

Figure 4: Deskew-View values
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Prerun checklist

Each input channel has its own deskew settings. Deskew compensates individual
channels for probes or cables of different lengths. The instrument applies the
delay values after each completed acquisition. The deskew values are saved as
part of the instrument setup. The deskew values for the selected channel are
retained until you change the probe, you restore a saved setup, or you recall the
factory setup.

NOTE. If you perform the de-embed settings, then performing the Deskew and
Attenuation settings are not required.

Select tests, set acquisition parameters, set configuration parameters, set
preferences parameters, and click Start to run the tests. While tests are running,
you cannot access the Setup or Reports panels. To monitor the test progress,
switch between the Status panel and the Results panel.

While the tests are running, other applications may display windows in the
background. The TekScope application takes precedence over other applications,
but you can switch to other applications by using Alt + Tab key combination. To
keep the TekExpress 10G-KR application on top, select Keep On Top from the
TekExpress Options menu.

The application displays report when the tests execution is complete.

1. Make sure that the instruments are warmed up (approximately 20 minutes)
and stabilized.

2. Perform compensation: In the oscilloscope main menu, select Utilities >
Instrument Compensation. Click Help in the compensation window for
steps to perform instrument compensation.
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Signaling speed
Reference: IEEE 802.3ap, section 72.7.1.3

This measurement measures the signaling speed using the recommended PRBS11
signal. The 10GBASE-KR signaling speed should be 10.3125 GBd + 100 ppm.

Required test equipment

Minimum system requirements

Equipment connection diagram

Inputs

PRBS signal

Measurement procedure

1. Compute the differential signal (Mathl = Dp - Dn).

2. Compute Period using DPOJET with Math1 as source.

3. The required result is 1/Period (mean).

Differential peak-to-peak output voltage (max)
Reference: IEEE 802.3ap, section 72.7.1.4

This measurement measures the differential peak-to-peak output voltage (max)
using the recommended 1010 signal. The differential output voltage is
constrained through the transmitter output waveform requirements specified in
72.7.1.10 of IEEE 802.3ap. The peak-to-peak differential output voltage should
be less than 1200 mV, regardless of equalization setting. The differential output
voltage test pattern should consist of at least eight symbols of alternating polarity.

Required test equipment

Minimum system requirements

Equipment connection diagram

Inputs

1010 signal

Measurement procedure

1. Identify the regions with the pattern 1010 or 0101 on the input signal.

2. Measure the high voltage and low voltage in that region.
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3. The voltages corresponding to the signal high and signal low regions are
taken as vHigh and vLow respectively. Compute the peak-to-peak (Vpi_pi)
voltage by vHigh — vLow.

4. The Vi pi values are averaged across all regions (the required result for the
differential peak-to-peak measurement).

Differential peak-to-peak output voltage (max) with Tx disabled

40

Reference: IEEE 802.3ap, section 72.6.5

This measurement measures the differential peak-peak output voltage (max) with
Tx disabled. Noise signal is captured when the Transmitter is disabled. The
transmitter output voltage should be less than 30 mV peak-to-peak when
disabled.

Required test equipment

Minimum system requirements

Equipment connection diagram

Inputs

Noise signal is captured when the Transmitter is disabled
Measurement procedure

1. Measure the high voltage and low voltage in the waveform.

2. The voltages corresponding to the signal high and signal low regions are
taken as vHigh and vLow respectively. Compute the peak-to-peak (Vpipi)
voltage by vHigh — vLow.

TekExpress® 10G-KR Printable Application Help



10G-KR compliance measurements

Common mode voltage limits

Reference: IEEE 802.3ap, section 72.7.1.4

This measurement measures the common mode voltage limits using the
recommended PRBS11 signal. The common mode voltage of SL(p) and SL(n)
should be between 0 V and 1.9 V with respect to signal ground.

Required test equipment
Minimum system requirements
Equipment connection diagram
Inputs

In case of single-ended mode common mode signal is created using Data positive
(Dp) and Data Negative signals (Dn). In case of Trimode probes, the waveform is
captured by setting the probe into Common mode.

Measurement procedure

1. Mathl = (Dp + Dn) + 2. Switch off channels connected to Dp and Dn.
2. From the Measure menu, select Amplitude > Peak-to-Peak.

3. Select Mathl as the measurement source.
4

Do a single-step run and measure the mean value of the histogram standard
deviation. This is the measurement result.

Common mode voltage deviation during LPI mode
Reference: IEEE 802.3ap, section 72.7.1.4

This measurement measures the common mode voltage deviation when the DUT
is switched from Normal mode to LPI mode. The common mode voltage in LPI
mode shall not deviate by more than 150mV when compared to the common
mode voltage in Normal mode.

Required test equipment
Minimum system requirements
Equipment connection diagram
Inputs

In case of single-ended mode common mode signal is created using Data positive
(Dp) and Data Negative signals (Dn). In case of Trimode probes, the waveform is
captured by setting the probe into Common mode.
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Transition time

42

Measurement procedure
1. Set the DUT in Normal mode and measure the common mode voltage.
2. Set the DUT in LPI mode and measure the common mode voltage.

3. Measure the deviation in common mode voltages between Normal mode and
LPI mode. The difference in voltage should not exceed 150 mV.

Reference: IEEE 802.3ap, section 72.7.1.7

This measurement measures the transition time (Rise time and Fall time) using
the recommended N1NO signal where N is between 8 and 11 (inclusive). The
rising and falling edge transition times should be between 24 ps and 47 ps as
measured at 20% and 80% levels, referenced to v2 and v5, as defined in
72.7.1.11 of IEEE 802.3ap. The measurement is done using the square wave test
pattern with no equalization and a run of at least eight consecutive ones and
zeroes.

Required test equipment

Minimum system requirements

Equipment connection diagram

Inputs

A differential N1NO signal (where N lies between 8 and 11, both inclusive).
Measurement algorithm

1. Obtain the values of the upper limit (V2) and lower limit (V5) from the
Output Waveform Characteristics measurement.

2. Find the position of the rising and falling edges in the input waveform.

3. On each rising edge, traverse forward until the first point crossing the upper
limit (80%) is found (=End) and traverse backward until the first point
crossing the lower limit (20%) is found (= Start).

4. On each falling edge, traverse backward until the first point crossing the
upper limit (80%) is found (=Start) and traverse forward until the first point
crossing the lower limit (20%) is found (=End).

5. Compute the Transition Time, TT = (End — Start). This value is averaged
across all edges.
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Max output jitter (peak-peak)

Reference: IEEE 802.3ap, section 72.7.1.8

This measurement verifies that the RMS value of the common mode signal is
within the conformable limits according to the specification.

Required test equipment

Minimum system requirements

Equipment connection diagram

Inputs

Pattern 2/3

Measurement algorithm (random jitter and deterministic jitter)

1. Deskew the Data+ and Data— inputs. Compute the differential signal on
Mathl = Dp — Dn.

2. Use DPOJET measurement RJ (Jitter tab) on the Math signal.
Measurement algorithm (total jitter)

1. Deskew the Data+ and Data- inputs. Compute the differential signal on
Mathl = Dp — Dn.

2. Use DPOJET measurement TJ@BER (Jitter tab) on the Math signal.

Duty cycle distortion

Reference: IEEE 802.3ap, section 72.7.1.9

This measurement verifies that the RMS value of the common mode signal is
within the conformable limits according to the specification.

Required test equipment

Minimum system requirements

Equipment connection diagram

Inputs

1010 signal

Measurement algorithm (duty cycle distortion)

1. Check if the input waveform pattern is a square wave test pattern.

2. Ifthe input is a square wave test pattern, check for a number of continuous
ones (between 8 and 11) in the test pattern.
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3. Estimate the UI of the waveform (UI = bit duration). Identify the edges on
the input waveform and the regions with patterns 1010 or 0101.

4. Find the absolute value of the difference in the mean pulse width of a 1 pulse
or the mean pulse width of a 0 pulse (from 1010 or 0101 patterns) and the
nominal pulse width (estimated UI).

Transmitter output waveform characteristics
Reference: IEEE 802.3ap, section 72.7.1.10

This measurement measures the output waveform characteristics using the
recommended N1NO signal where N is between 8 and 11 (inclusive).

The test pattern for the transmitter output waveform is the square wave test
pattern as defined in 52.9.1.2 of IEEE 802.3, with a run of at least eight
consecutive ones. The transmitter output waveform test is based on the voltages
vl through v6, Av2, and Av5, which should be measured as shown in Figure 72—
12 of IEEE 802.3ap.

Required test equipment

Minimum system requirements

Equipment connection diagram

Inputs

A NINO signal (where N lies between 8 and 11, both inclusive).
Measurement procedure

1. Check if the input waveform pattern is a square wave test pattern.

2. Ifthe input is a square wave test pattern, check for a number of continuous
ones (between 8 and 11) in the test pattern.

3. Determine if the starting edge is rising or falling. Depending on the result,
measure the voltages v1, v2, v3, v4, v5, v6, Rpre, and Rpst according to the
specification. Average the computed values across all the regions.

4. The values of v2 and v5 are considered as the upper and lower limits for
transition time measurement.
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Output waveform coefficient update
Reference: IEEE 802.3ap, section 72.7.1.11a

This measurement measures the output waveform coefficient update and status
using the recommended N1NO signal where N is between 8 and 11 (inclusive).

The state of the transmitter equalizer and hence the transmitter output waveform
is manipulated through the protocol defined in 72.6.10 of IEEE 802.3ap or
through management. The changes in the transmitter output waveform resulting
from coefficient update requests should meet the requirements stated in Table
72—7 of IEEE 802.3ap specification. The coefficient update requests in Table 72—
7 of IEEE 802.3ap are to be followed by a coefficient update equal to hold for all
taps. The results should be verified after the coefficient status for all taps is
reported as not updated. For any coefficient update, the magnitudes of the
changes in v1, v2, and v3 should be within 5 mV of each other. When sufficient
increment or decrement updates have been applied to a given tap, it will reach a
maximum or minimum limit, governed by the coefficient range or by restrictions
placed on minimum steady-state or maximum peak voltage, and the coefficient
status is reported accordingly.

The transmitter output waveform should meet the requirements of Table 728 of
IEEE 802.3ap for all of the limiting cases represented in the table.
Implementation of c(—1) or c(1) coefficient values greater than zero or less than
the minimum defined by Rpre (min) and Rpst (min) is optional. A coefficient
may be disabled by first asserting the preset control defined in IEEE 802.3 Table
45-55 and 45.2.1.78, then manipulating the other coefficients as required by the
test.

Required test equipment
Minimum system requirements
Equipment connection diagram
Inputs

A NINO signal (N lies between 8 and 11, both inclusive) of the same pattern with
different acquisitions captured at different states (1 through 6).

Measurement procedure
1. Check if each input waveform pattern is a square wave test pattern.

2. Ifthe inputs are square wave test patterns, check for a number of continuous
ones (between 8 and 11) in the test patterns.

3. Determine if the starting edge is rising or falling. Depending on the result,
measure the voltages v1, v2, v3, v4, v5, v6, Rpre, and Rpst according to the
specification. Average the computed values across all the regions.

4. Compute Rpre and Rpst values from above computed voltages. Rpre = v3/v2,
Rpst = v1/v2 for all input waveforms.

5. Calculate V1(k)-V1(k-1),V2(k)-V2(k-1),V3(k)-V3(k-1) for all input
waveforms where K varies from 1 to 6.
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Output waveform coefficient status
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Reference: IEEE 802.3ap, section 72.7.1.11b

This measurement measures the output waveform coefficient update and status
using the recommended N1NO signal where N is between 8 and 11 (inclusive).

The state of the transmitter equalizer and hence the transmitter output waveform
is manipulated through the protocol defined in 72.6.10 of IEEE 802.3ap or
through management. The changes in the transmitter output waveform resulting
from coefficient update requests should meet the requirements stated in Table
72—7 of IEEE 802.3ap. The coefficient update requests in Table 72—7 of IEEE
802.3ap are to be followed by a coefficient update equal to hold for all taps. The
results should be verified after the coefficient status for all taps is reported as
not_updated. For any coefficient update, the magnitudes of the changes in v1, v2,
and v3 should be within 5 mV of each other. When sufficient increment or
decrement updates have been applied to a given tap, it will reach a maximum or
minimum limit governed by the coefficient range or by restrictions placed on
minimum steady-state or maximum peak voltage, and the coefficient status is
reported accordingly.

The transmitter output waveform should meet the requirements of Table 72—-8 of
IEEE 802.3ap for all of the limiting cases represented in the table.
Implementation of c(—1) or c(1) coefficient values greater than zero or less than
the minimum defined by Rpre (min) and Rpst (min) is optional. A coefficient
may be disabled by first asserting the preset control defined in IEEE 802.3 Table
45-55 and 45.2.1.78, then manipulating the other coefficients as required by the
test.

Required test equipment
Minimum system requirements
Equipment connection diagram
Inputs

A NINO signal (N lies between 8 and 11, both inclusive) of the same pattern with
different acquisitions captured at different states (1 through 4).

Measurement procedure
1. Check if each input waveform pattern is a square wave test pattern.

2. Ifthe inputs are square wave test patterns, check for a number of continuous
ones (between 8 and 11) in the test patterns.

3. Determine if the starting edge is rising or falling. Depending on the result,
measure the voltages v1, v2, v3, v4, v5, v6, and Rpre, Rpst according to the
specification. Average the computed values across all the regions.

4. Compute Rpre and Rpst values from above computed voltages. Rpre = v3/v2,
Rpst = v1/v2 for all input waveforms.
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About SCPl command

You can use Standard Commands for Programmable Instruments (SCPI) to

communicate with the TekExpress application.

Socket configuration for SCPI commands

This section describes the steps for TCPIP socket configuration and TekVISA

configuration to execute the SCPI commands.

TCPIP socket 1.
configuration

Click Start > Control Panel > System and Security > Windows Firewall >
Advanced settings

e

:Eg

—
@uvlﬂ » Control Panel » System and Security » Windows Firewall - | &,l

Search Con... O |

Control Panel Home

Allow a program or feature
through Windows Firewall

) Change notification settings

%) Turn Windows Firewall on or
off

| Restore defaults
[ ) Advanced settings

Troubleshoot my network

See also
MAction Center

Network and Sharing Center

Help protect your computer with Windows Firewall

Windows Firewall can help prevent hackers or malicious software from gaining access to your computer
through the Internet or a network.,

How does a firewall help protect my computer?

What are network locations?

@ For your security, some settings are managed by your system administrator.

. [@ Domain networks

Metworks at a workplace that are attached to a domain

Connected (4)

Windows Firewall state: On

Incoming connections: Block all connections to programs that are not on the

list of allowed programs

Active domain networks: ij tektroniz.net

Metification state: Do net notify me when Windows Firewall blocks a

new program

. '@ Home or work (private) networks Not Connected V

. '@) Public networks

Not Connected (¥

@
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2. In Windows Firewall with Advanced Security menu, select Windows
Firewall with Advanced Security on Local Computer > Inbound Rules
and click New Rule...

r 3
@ Windows Firewall with Advanced Security =S

File Action View Help

EY

P Windows Firewall with Advancd [l Actions

Inbound Rul B
DDOUNG LU e Mame Group Profile  Ensbled  Action Inbaund Rules -
Outbound Rules :
B Connection Security Rules B3 NewRuie...
» % Monitoring T Filter by Profile

W Fiter by State
Y Fiter by Group

v v ¥l

View
[ Refresh
|5 Exportlist...
Help
Tektronix VISA Call Monitor &
# Disable Rule

& cut

52 Copy

K Delete

[E] Properties

Help

< m v ||l m

3. In New Inbound Rule Wizard menu
a. Select Port and click Next

-
ﬂ New Inbound Rule Wizard ﬂ

Rule Type
Select the type of firewall nule to create.

Steps:

@ Rule Type What type of nule would you like to create?

@ Protocol and Ports

@ Action ) Program

@ Prefile Rule that controls connections for a program.
@ MName @ Port

Rule that controls connections for a TCP or UDP port.
) Predefined:

BranchCache - Content Retrieval {Uses HTTF)
Fule that controls connections for 8 Windows experience.

Custom rule.

Leam more about nile types

< Back Neat > Cancsl
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b. Select TCP as rule apply and enter 5000 for Specific local ports and
click Next

-
0 New Inbound Rule Wizard ﬂ

Protocol and Ports
Specify the protocols and ports to which this rule applies.

Steps:

@ Rule Type Does this rule apply to TCP or UDP?
@ Protocol and Ports @ TCP

@ Action ) UDP

@ Profile

@ Name

Does this rule apply to all local ports or specific local ports?

1 All local ports

@ Specific local ports: 5000
Example: 80, 443, 5000-5010

Leam more about protocol and ports

<Back [ Net> | [ Cancel

c. Select Allow the connection and click Next

-
ﬂ MNew Inbound Rule Wizard ﬁ

Action

Specify the action to be taken when a connection matches the conditions specfied in the rule.

Steps:
@ Rue Type What action should be taken when a connection matches the specified conditions?
@ Protocol and Ports .

: @ Allow the connection
L) BRI This includes connections that are protected with IPsec as well as those are not.
@ Profile .

) Allow the connection if it is secure

@ Name

This includes only connections that have been authenticated by using IPsec. Connections
will be secured using the settings in |Psec properties and nules in the Connection Security
Rule node

") Block the connection

Leam more about actions

<Back [ Net> ][ Cancel

TekExpress® 10G-KR Printable Application Help

49



SCPI commands

50

d.

.

Select Domain, Private, Public and click Next

-
ﬂ New Inbound Rule Wizard

Profile

Specify the profiles for which this rule applies.

Steps:

@ Fuls Type When does this rule apply?

@ Protocol and Ports

@ Action Domain

@ Profile Applies when a computer is connected to its corporate domain.
@ MName Private

Applies when a computer is connected to a private network location.

Public
Applies when a computer is connected to a public network location

Leam more about profiles

<Back [ Net> ||

Cancel

Enter Name, Description (optional), and click Finish

-
ﬂ MNew Inbound Rule Wizard

Name

Specify the name and description of this rule

Steps:

Rule Type
Protocol and Ports
Action

Profiie Name:

TekExpresyd

& & & & &

Name

Description {optional):

<Back [ Finish

J {

Cancel
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4. Check whether the Rule name is displayed in Windows Firewall with
Advanced Security menu > Inbound Rules

r
@ Windows Firewall with Advanced Security =S

File Acton View Help
| HE =

Inbound Rul
Mlobound Rules Name Group Profile  Enabled  Action “ || Inbound Rules -
Outbound Rules

Y. Connection Security Rules || SHUEEEIES All Ves Allow &3 NewRue...
& %L Monitoring T Filter by Profile

N Filter by state
Y Fiter by Group

v v v v

View
[ Refresh
|5 Exportlist...
H reb
TekExpress -
# Disable Rule

& cut

g Copy

K Delete

[E] Properties

H Hep
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TekVISA configuration

1.

Click Start > All Programs > TekVISA > OpenChoice Instrument

Manager

CpenChoice Instrument Manager

Fle Edit Help

Instruments

GPIB8::1::INSTR

< | m

Last Updated: 12/17/2015 10:34 PM

Instrument List Instrument
Update Identify...

w | O

Search Criteria.. Properties.

Applications and Utilities

OpenChoice Call Monitor
OpenChoice Talker Liste. ..

Start Application or Utility

Tekironix

TekExpress® 10G-KR Printable Application Help




SCPI commands

2. Click Search Criteria. In Search Criteria menu, click LAN to Turn-on.
Select Socket from the drop-down list, enter the IP address of the

TekExpress device in Hostname and type Port as 5000. Click to
configure the IP address with Port.

Enter the Hostname as 127.0.0.1 if the TekVISA and TekExpress application
are in the same system, else enter the IP address of the TekExpress
application system.

-
Search Criteria | =

v Search LAM

[~ Auto Discovery

Hostname Port
|Socket ~| | |[s000 |

[Socket| 127.0.0.1 5000
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3. Click Search to setup the TCPIP connection with the host. Check whether

the TCPIP host name is displayed in OpenChoice Instrument Manager >

Instruments

OpenChoice Instrument Manager [=[E[T=n]

Fle Edit Help

Instruments Applications and Utilities

OpenChoice Call Monitor
OpenChoice Talker Liste

<[ i
Last Updated: 12/17/2015 10:35 PM
Instrument List
Update
“ Start Application or Utility
-~

Search Criteria.-

Tekironix

¥ Search LAN

I~ Auto Discovery

Hostname Port

(s I—

[Eackef] 127.0.0.1 5000

Double-click OpenChoice Talker Listener and enter the Command *IDN?
in command entry field and click Query. Check that the Operation is
successful and Talker Listener Readout displays the Command / Data.

-
3 OpenChoice Talker Listener = ne

fle Edit Toos Help

Enter Command or Script
"IDN?

Wite  Read  Query  Hex Eniry Enabled
( . . |

Command / Seript History

Last Updated 12/17/2015 10:36 PM JAutoQuery - False ; Term Char - LF

Update Reset Communications Run Single Step Loop
S A 4

Talker Listener Readout: Display As: @ ASCIOnly @ Hex and ASCI

Command / Data
12/17/2015 10:... 0.0170s VISA TCPIP::127.0.0.1::5000::50CKET Qpen Session
1217/2015 1 0.0008s MS054 . *IDN? Write

121772015 1 0.0775s TCPIP:... TekExpress Read

@ Operation Successful
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TEKEXP:*IDN?

Syntax

Inputs

Outputs

[::;ﬂ

TEKEXP:*OPC?

Syntax

Inputs

Outputs

This command queries the active TekExpress application name running on the
oscilloscope.

TEKEXP:*IDN?\n

NA

Returns active TekExpress application name running on the oscilloscope.

TIP. Click here for examples.

This command queries the execution status of the last executed command.

TEKEXP:*OPC?\n

NA

0 - last command execution is not complete

1 - last command execution is complete

TIP. Click here for examples.
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TEKEXP:ACQUIRE_MODE

Syntax

Inputs

Outputs

I:’:;:—r

This command sets the acquire mode as live or pre-recorded.

TEKEXP:ACQUIRE _MODE {LIVE | PRE-RECORDED}\n

{LIVE | PRE-RECORDED}

NA

TIP. Click here for examples.

TEKEXP:ACQUIRE_MODE?

Syntax

Inputs

Outputs

o

56

This command queries the acquire mode type.

TEKEXP:ACQUIRE MODE?\n

NA

{LIVE | PRE-RECORDED}

TIP. Click here for examples.
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TEKEXP:EXPORT

Inputs

Ty

TEKEXP:INFO?

This command returns all the bytes of data to the specified file.

Syntax

Outputs

TEKEXP:EXPORT REPORT\n

Returns the report file in bytes

TEKEXP:EXPORT WFM,"<FileName>"\n

Returns the specified waveform file in bytes

TEKEXP:EXPORT IMAGE,"<FileName>"\n

Returns the specified image file in bytes

FileName - Specifies the file name

TIP. Click here for examples.

This command queries the information about the file(s).

Syntax

Outputs

TEKEXP:INFO? REPORT\n

<ReportFileSize>,"<ReportFileName.mht>"

TEKEXP:INFO? WFMi\n

<WfmFile1Size>,"<WfmFileName1.wfm>";<Wfm
File2Size>,"<WfmFileName2.wfm>";...

TEKEXP:INFO? IMAGE\n

<Image1FileSize>,"<Image1FileName>";<Image
2FileSize>,"<Image2FileName>" ;...

TIP. Click here for examples.
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TEKEXP:INSTRUMENT

This command sets the value for the selected instrument type.

Syntax ~ TEKEXP:INSTRUMENT "<InstrumentType>",<Value>"\n

Inputs  InstrumentType

Value
o TIP. Check Command parameters list for InstrumentType and Value parameters.
Outputs NA
w TIP. Click here for examples.

TEKEXP:INSTRUMENT?

This command queries the instrument selected for the specified instrument type.

Syntax ~ TEKEXP:INSTRUMENT? "<InstrumentType>"\n

Inputs  InstrumentType

TIP. Check Command parameters list for InstrumentType parameters.

o
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Outputs  Returns the instrument selected for the specified instrument type

o TIP. Click here for examples.

TEKEXP:LASTERROR?

This command queries the last error string occurred for the current TCP session.
If there are no errors since startup, or since the last call to
TEKEXP:LASTERROR?\n, this command returns an empty string.

Syntax ~ TEKEXP:LASTERROR?\n

Inputs NA

Outputs  <string>

o TIP. Click here for examples.

TEKEXP:LIST?

This command queries the list of available device, suite, test, version or

instrument.

Syntax Outputs

TEKEXP:LIST? DEVICE\n Returns the list of available device(s) as comma
separated values.

TEKEXP:LIST? SUITE\n Returns the list of available suite(s) as comma
separated values.

TEKEXP:LIST? TEST\n Returns the list of available test(s) as comma
separated values.

TEKEXP:LIST? VERSION\n Returns the list of available version(s) as comma
separated values.

TEKEXP:LIST? Returns the list of available instruments' for the

INSTRUMENT,"<InstrumentType>"\n given Instrument type as comma separated
values.
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Inputs

TEKEXP:MODE

Syntax

Inputs

Outputs

I::‘;:—r

60

NOTE. This command returns the list of items within double quotes ("'"). Iterate
the receive procedure until the list ends with double quotes otherwise the next
query commands won’t work as expected.

InstrumentType

TIP. Check Command parameters list for InstrumentType parameters.

TIP. Click here for examples.

This command sets the execution mode as compliance or user defined.

TEKEXP:MODE {COMPLIANCE | USER-DEFINED}\n

{COMPLIANCE | USER-DEFINED}

NA

TIP. Click here for examples.
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TEKEXP:MODE?

This command queries the execution mode type.

Syntax ~ TEKEXP:MODE?\n

Inputs NA

Outputs ~ {COMPLIANCE | USER-DEFINED}

" TIP. Click here for examples.

TEKEXP:POPUP

This command sets the response to the active popup shown in the application.

Syntax ~ TEKEXP:POPUP “<PopupResponse>"\n

Inputs  PopupResponse

Outputs NA

o TIP. Click here for examples.
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TEKEXP:POPUP?

Syntax

Inputs

Outputs

I:’:;:—r

TEKEXP:REPORT

Syntax

Inputs

Outputs

o

62

This command queries the active popup information shown in the application.

TEKEXP:POPUP?\n

NA

Returns the active popup information in the application.

TIP. Click here for examples.

This command generates the report for the current session.

TEKEXP:REPORT GENERATE\n

GENERATE

NA

TIP. Click here for examples.
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TEKEXP:REPORT?

Syntax

Inputs

Outputs

[

TEKEXP:RESULT?

This command queries the queried header field value in the report.

TEKEXP:REPORT? “<HeaderField>"\n

HeaderField - Specifies to return the measured value for the indicated test.

TIP. Check Report for HeaderField parameters.

Returns the queried header field value in the report

TIP. Click here for examples.

This command queries the result available in report summary/details table.

Syntax Outputs

TEKEXP:RESULT? "<TestName>"\n Return Pass/Fail status of the test.
TEKEXP:RESULT? Returns all the row values of the specified
"<TestName>","<ColumnName>"\n column for the test.

TEKEXP:RESULT? Returns the column value for the specified row

"<TestName>","<ColumnName>",<RowNumber
>\n

number !

1" Row number starts from zero.
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Inputs

TEKEXP:SELECT

Syntax

Inputs

64

TestName - Specifies the name of the test for which to obtain the test result

value.

ColumnName - Specifies the column name for the measurement

RowNumber - Specifies the row number of the measurement

TIP. Check Results panel for TestName, ColumnName, and RowNumber

parameters.

TIP. Click here for examples.

This command selects the device, suite, version, or test.

TEKEXP:SELECT <string1>,<string2>,<string4>\n
TEKEXP:SELECT TEST,<string3>,<string4>\n

<string1>= {DEVICE | SUITE | VERSION}
<string2> = {DeviceName | SuiteName | VersionName}

<string3> = {“<TestName>"| ALL| REQUIRED }

<string4>= {TRUE | FALSE}

TIP. Check Command parameters list for DeviceName, SuiteName, VersionName,

and TestName parameters.

TIP. Click here for examples.
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Outputs NA

TEKEXP:SELECT?

This command queries the name of the selected device, suite, version, or test.

Syntax ~ TEKEXP:SELECT? {DEVICE | SUITE | TEST | VERSION}\n

Inputs  {DEVICE | SUITE | TEST | VERSION}

Outputs  Returns the name of the selected device, suite, version, or test.

o TIP. Click here for examples.

TEKEXP:SETUP
This command sets the value of the current setup.
Syntax Outputs
TEKEXP:SETUP DEFAULT\n Restore to default Setup
TEKEXP:SETUP OPEN,"<SessionName>"\n | Open the session
TEKEXP:SETUP SAVE\n Save the session
TEKEXP:SETUP SAVE,"<SessionName>"\n Save the session

Inputs  SessionName - The name of the session

o TIP. Click here for examples.
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TEKEXP:STATE

Syntax

Inputs

Outputs

[:_::—

TEKEXP:STATE?

66

This command sets the execution state of the application.

TEKEXP:STATE {RUN | STOP | PAUSE | RESUME}\n

{RUN | STOP | PAUSE | RESUME}

NA

TIP. Click here for examples.

This command queries the current setup state.

Syntax Outputs

TEKEXP:STATE? RUNNING | PAUSED | WAIT | ERROR | READY
| STOPPED

TEKEXP:STATE? SETUP SAVED | NOT_SAVED

TIP. Click here for examples.
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TEKEXP:VALUE

This command sets the value of parameters of type General, Acquire, Analyze, or
DUTID.

Syntax =~ TEKEXP:VALUE GENERAL,"<ParameterName>",“<Value>"\n

TEKEXP:VALUE ACQUIRE,“<TestName>","<AcquireType>",
"<ParameterName>",“<Value>"\n

TEKEXP:VALUE ANALYZE,“<TestName>","<ParameterName>".“<Value>"
\n

TEKEXP:VALUE DUTID,“<Value>"\n

Inputs  ParameterName - Specifies the parameter name
TestName - Specifies the test name
AcquireType - Specifies the acquire type

Value - Specifes the value to set

TIP. Check Command parameters list for ParameterName, AcquireType, and

wwr Value parameters.
Outputs NA
v TIP. Click here for examples.
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TEKEXP:VALUE?
Inputs
[
Outputs
[
68

This command queries the value of the parameter for type General, Acquire,
Analyze, or DUTID.

Syntax Outputs

TEKEXP:VALUE? Returns the value of Parameter for type
GENERAL,"<ParameterName>"\n GENERAL

TEKEXP:VALUE? ACQUIRE,"<TestName>", | Returns the value of Parameter for type
"<AcquireType>","<ParameterName>"\n ACQUIRE

TEKEXP:VALUE? ANALYZE, Returns the value of Parameter for type
“<TestName>","<ParameterName>"\n ANALYZE

TEKEXP:VALUE? DUTID\n Returns the DUTID value

ParameterName - Specifies the parameter name
TestName - Specifies the test name

AcquireType - Specifies the acquire type

TIP. Check Command parameters list for ParameterName and AcquireType
parameters.

Returns the value of Parameter for type GENERAL | ACQUIRE | ANALYZE |
DUTID.

TIP. Click here for examples.
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Command parameters list

TekExpress 10G-KR
command parameters

This section provides the parameters list for the SCPI commands.

ParameterName and Value for DUT, Test selection, Acquisition,
Configuration and Preferences tabs

Specifies the ParameterName and Value for DUT, Test selection, Acquisition,
Configuration, and Preferences tabs

Table 16: ParameterName and Value for DUT tab

Parameters

Description

Instrument Type

Specifies the instrument type.
Valid value is: Realtime Scope

DUTID

Specifies the value parameters.
For DUTID, valid value is; Comment
For Instrument Type, valid values are:

= Donotuse
= GPIB8:1:INSTR

Link Widths

Specifies the lane.

Valid values are 1 Lane, 2 Lanes, and 4 Lanes.

Probing Type

Specifies the selected source.
Valid values are Single-ended, Differential
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Table 17: ParameterName and Value for Test Selection tab

Parameters

Description

TestName

Specifies the test measurement name.
Valid values for 10G-KR are:

Signaling speed

Differential peak-to-peak output voltage (max)

Differential peak-peak output voltage (max) with Tx disabled
Transition time

Max output jitter (peak-peak)

Duty Cycle Distortion

Transmitter output waveform characteristics

Coefficient update - C(0) Increment

Coefficient update - C(0) Decrement

C
C(1) Increment
1

Coefficient update - C(1)
) Decrement
Coefficient update - C(-1) Increment

1

(
(
Coefficient update - C(
(
(-1) Decrement

C(-1)
Coefficient update - C(-1)
Status C(1)Disabled_C(0)Maximum_C(-1)Disabled
Status C(1)Disabled_C(0)Minimum_C(-1)Disabled
Status C(1)Disabled_C(0)Minimum_C(-1)Minimum
Status C(1)Minimum_C(0)Minimum_C(-1)Disabled

Common mode voltage limits

Common mode voltage limits-LPI

70
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Table 18: ParameterName and Value for Configuration tab

Parameters Description
Mode Specifies the mode.
Valid values are:
= Compliance
m  User-Defined
Apply Filter Specifies the De-embedding filter. Valid values are:
= True
m False
Phase Inverted Filter For Data . Tree
m False

Data Positive De-Embedding
filter

Complete Path of filter file has to be updated

Data Negative De-Embedding
filter

Complete Path of filter file has to be updated

Table 19: ParameterName and Value for Aquisition tab

Parameters

Description

Signal Validation

Specifies the signal validation. Valid values are:
m  Skip Test if Signal Validation Fails
= Use signal as is - Don't Validate

=  Prompt me if Signal Validation Fails
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Table 20: ParameterName and Value for Acquire

Test Name

Acquire Type

Parameter Name

Values

Signaling speed

Pseudo-random pattern

Differential peak-to-peak output voltage
(max)

1010 Square pattern

Transition time

N1NO Square pattern

Max output jitter (peak-peak)

Pseudo-random pattern

Duty Cycle Distortion

1010 Square pattern

Transmitter output waveform characteristics

N1NO Square pattern

Coefficient update - C(0) Increment

C(0) Increment - Output waveform coefficient
update acquisition

Coefficient update - C(0) Decrement

C(0) Decrement - Output waveform
coefficient update acquisition

Coefficient update - C(1) Increment

C(1) Increment - Output waveform coefficient
update acquisition

Coefficient update - C(1) Decrement

C(1) Decrement - Output waveform
coefficient update acquisition

Coefficient update - C(-1) Increment

C(-1) Increment - Output waveform
coefficient update acquisition

Coefficient update - C(-1) Decrement

C(-1) Decrement - Output waveform
coefficient update acquisition

Ratus
C(1)Disabled_C(0)Maximum_C(-1)Disabled

Output waveform status TekExpress

C(1)Disabled_C(0)Maximum_C(-1)Disabled

Signal type

® 10G-KR Printab

PRBS7

PRBS9

PRBS11
PRBS15
PRBS20
PRBS23
PRBS31

1010
PRBS7
RBS9
PRBS11
PRBS15
PRBS20
PRBS23
PRBS31

N1NO

JitterCompliance

PRBS7

PRBS9

PRBS11
PRBS15
PRBS20
PRBS23
PRBS31

N1NO

le Application Helg
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Table 21: ParameterName and Value for Analyze

Test Name

Parameter Name Values

Max output jitter (peak-peak)

10,12

Target BER (1e-)

Table 22: ParameterName and Value for Preferences tab

Popup

Parameters Description
Run Test More than Once

= True

= False
Number of Runs 110250
On Failure Stop and Notify . True

= False
Timer Warning Info Message . True
Popup

= False
Timer Warning Info Message 1t060

ParameterName and Value for General, Acquire and Analyze

Specifies the ParameterName and Value for General, Acquire and Analyze. The
configuration parameters available are not same for measurements.

Table 23: ParameterName and Value for General

ParameterName Value
Report Update Mode . New
= Append
= Replace

= ReplaceAny

Replace Run session Path

Session file path.
Example: X:\10G-KR\Session1\DUT001\20170421_121534

Include Header In Appended True

Report False

Save As Type = Web Archive (*.mht:* mhtmi)
= PDF (*.pdf)

Auto increment report name if

. True

duplicate

= False
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ParameterName Value
Create report at the end . True

= False
Include pass/fail results Summary . True

= False
Include detailed results

= True

= False
Include plot images . True

= False
Include setup configuration Trie

= False
Include user comments

= True

= False
View report after generating True

= False
State Specifies the state. Valid values are

= RUN

= PAUSE

= RESUME

= STOP
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Examples
This section provides the examples for the SCPI commands.
Example Description
TEKEXP:*IDN?\n It returns the active TekExpress application name running on the
scope.
TEKEXP:*OPC?\n It returns the last command execution status. i.e., (1,0)

TEKEXP:INSTRUMENT "Real Time Scope",DPO77002SX
(GPIB8::1:INSTR)\n

It sets the instrument value as DPO77002SX ( GPIB8::1::INSTR )
for the selected instrument type Real Time Scope.

TEKEXP:INSTRUMENT? “Real Time Scope™\n

It returns "DPO77002SX ( GPIB8::1::INSTR ),MSO73304DX
(TCPIP::134.64.248.91::INSTR )" when

DPO72504D( GPIB8::1::INSTR ), MSO73304DX ( TCPIP::
134.64.248.91::INSTR ) are the list of available instruments.

TEKEXP:SETUP DEFAULT It sets the default settings.
TEKEXP:VALUE? DUTID It returns the DUTID.
TEKEXP:VALUE DUTID, "10GKR" It sets the DUTID.

TEKEXP:ACQUIRE_MODE?

It returns the selected acquisition mode i.e. (LIVE, PRE-
RECORDED).

TEKEXP:ACQUIRE_MODE PRE-RECORDED

It sets the PRE-RECORDED acquisition mode.

TEKEXP:ACQUIRE_MODE LIVE

It sets the live acquisition mode.

TEKEXP:VALUE? GENERAL, "Probing Type"

It returns selected source i.e. (Single-Ended, Differential).

TEKEXP:VALUE GENERAL, "Probing Type", "Single-Ended"

It sets the source as "Single-Ended".

TEKEXP:VALUE GENERAL, "Probing Type", "Differential”

It sets the source as "Differential".

TEKEXP:VALUE? GENERAL, "Link Widths"

It returns selected lane i.e. (1 Lane, 2 Lanes, 4 Lanes).

EKEXP:VALUE GENERAL, "Link Widths", "2 Lanes"

It sets the lane as "2 Lanes".

TEKEXP:SELECT TEST, ALL, FALSE

Its de-select the all test.

TEKEXP:SELECT TEST, ALL, TRUE

Its select the all test.

TEKEXP:SELECT? TEST

It returns the all selected test.

TEKEXP:SELECT TEST, "Signaling speed”, TRUE

Its select the "Signaling speed” test.

TEKEXP:SELECT TEST, "Signaling speed", FALSE

Its de-select the "Signaling speed"” test.

TEKEXP:VALUE? ANALYZE,"Max output jitter (peak-peak)","Target
BER (1e-)"

It returns selected value.

TEKEXP:VALUE ANALYZE,"Max output jitter (peak-peak)”,"Target
BER (1e-)","10"

It sets the Target BER (1e-) as 10.

TEKEXP:VALUE? GENERAL, "Signal Validation"

It returns the selected signal validation option.

TEKEXP:VALUE GENERAL, "Signal Validation", "Skip Test if Signal
Validation Fails"

It sets the signal validation option as "Skip Test if Signal Validation
Fails".

TEKEXP:VALUE GENERAL, "Signal Validation", "Use signal as is -
Don't Validate"

It sets the signal validation option as "Use signal as is - Don't
Validate".

TTEKEXP:VALUE GENERAL, "Signal Validation", "Prompt me if
Signal Validation Fails"

It sets the signal validation option as "Prompt me if Signal Validation
Fails".

TEKEXP:VALUE? GENERAL, "Acquisition Save Options"

It returns the selected signal save option.
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Example

Description

TEKEXP:VALUE GENERAL, "Acquisition Save Options", "Save Al
Waveforms Before Analysis"

It sets the selected signal save option "Save All Waveforms Before
Analysis".

TEKEXP:MODE? It returns the mode i.e. (USER-DEFINED, COMPLIANCE).
TEKEXP:MODE COMPLIANCE It sets the mode as COMPLIANCE.
TEKEXP:MODE USER-DEFINED It sets the mode user as USER-DEFINED.

TEKEXP:VALUE? ACQUIRE,"Signaling speed","Pseudo-random
pattern","Signal type"

It returns the selected signal type i.e. PRBS11, PRBS9, PRBS7 etfc.

TEKEXP:VALUE ACQUIRE,"Signaling speed","Pseudo-random
pattern","Signal type","PRBS7"

It sets the signal type as PRBS7.

TEKEXP:VALUE? GENERAL, "Apply Filter"

It returns false if filter is not selected.

TEKEXP:VALUE GENERAL, "Apply Filter", "True"

It sets the De-Embedding filter as true.

TEKEXP:VALUE GENERAL, "Data Positive De-Embedding
filter","C:\Filter fit"

Its sets the filter file for data positive.

TEKEXP:VALUE GENERAL, "Data Negative De-Embedding
filter","C:\Filter fit"

Its sets the filter file for data negative.

TEKEXP:VALUE? GENERAL, "Run Test More than Once"

It returns the "True" or "False".

TEKEXP:VALUE GENERAL, "Run Test More than Once", "True"

It sets the "Run Test More than Once" as "True".

TEKEXP:VALUE? GENERAL, "Number of Runs"

It returns the selected value i.e."1"

TEKEXP:VALUE GENERAL, "Number of Runs", "100"

It sets the "Number of Runs" as "100".

TEKEXP:VALUE? GENERAL, "On Failure Stop and Notify"

It returns the "True" or "False".

TEKEXP:VALUE GENERAL, "On Failure Stop and Notify", "True"

It sets the "On Failure Stop and Notify" as "True".

TEKEXP:VALUE? GENERAL, "Timer Warning Info Message
Popup"

It returns the "True" or "False".

TEKEXP:VALUE GENERAL, "Timer Warning Info Message Popup”,
"False"

It sets the "Timer Warning Info Message Popup" as "False".

TEKEXP:VALUE? GENERAL, "Timer Warning Info Message Popup
Duration"

It returns the selected value i.e."10".

TEKEXP:VALUE GENERAL, "Timer Warning Info Message Popup
Duration", "3"

It sets the "Timer Warning Info Message Popup Duration" as "3".

TEKEXP:VALUE? GENERAL, "Timer Error Message Popup"

It returns the "True" or "False".

TEKEXP:VALUE GENERAL, "Timer Error Message Popup", "True"

It sets the "Timer Error Message Popup" as "True".

TEKEXP:VALUE? GENERAL, "Timer Error Message Popup
Duration"

It returns the selected value i.e."10".

TEKEXP:VALUE GENERAL, "Timer Error Message Popup
Duration", "60"

It sets the "Timer Error Message Popup Duration" as "60".

TEKEXP:VALUE? GENERAL, "Report Update Mode"

It returns the selected report update mode i.e. "New".

TEKEXP:VALUE GENERAL, "Report Update Mode", "Append"

It sets the "Report Update Mode" as "Append".

TEKEXP:VALUE GENERAL, "Report Settings:Include Header In
Appended Reports", "True"

It sets the "Report Settings:Include Header In Appended Reports" as
"True".

TEKEXP:VALUE GENERAL, "Report Update Mode", "Replace”

It sets the "Report Update Mode" as "Replace”.

TEKEXP:VALUE GENERAL, "Report Update Mode", "ReplaceAny"

It sets the "Report Update Mode" as "ReplaceAny".
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Example

Description

TEKEXP:VALUE? GENERAL, "Report Path"

It returns the selected report path "X:\10G-KR\Reports
\DUTO001.mht".

TEKEXP:VALUE? GENERAL, "Save As Type"

It returns the selected report type "Web Archive (*.mht;*.mhtml)".

TEKEXP:VALUE GENERAL, "Save As Type", "PDF (*.pdf;)"

It sets the report type as "PDF (*.pdf;)"

TEKEXP:VALUE? GENERAL, "Auto increment report name if
duplicate"

It returns the "True" or "False".

TEKEXP:VALUE GENERAL, "Auto increment report name if
duplicate", "True"

It sets the "Auto increment report name if duplicate" as "True".

It sets the "Auto increment report name if duplicate" as "True"

It returns the "True" or "False".

TEKEXP:VALUE GENERAL, "Create report at the end", "True"

It sets the "Create report at the end" as "True".

TEKEXP:VALUE? GENERAL, "Include Pass/Fail Results Summary"

It returns the "True" or "False".

TEKEXP:VALUE GENERAL, "Include Pass/Fail Results Summary",
"True"

It sets the "Include Pass/Fail Results Summary" as "True".

TEKEXP:VALUE? GENERAL, "Include Detailed Results"

It returns the "True" or "False".

TEKEXP:VALUE GENERAL, "Include Detailed Results", "True"

It sets the "Include Detailed Results" as "True".

TEKEXP:VALUE? GENERAL, "Include Plot Images"

It returns the "True" or "False".

TEKEXP:VALUE GENERAL, "Include Plot Images", "True"

It sets the "Include Plot Images" as "True".

TEKEXP:VALUE? GENERAL, "Include Setup Configuration"

It returns the "True" or "False".

TEKEXP:VALUE GENERAL, "Include Setup Configuration”, "True"

It sets the "Include Setup Configuration" as "True".

TEKEXP:VALUE? GENERAL, "Include Complete Application
Configuration”

It returns the "True" or "False".

TEKEXP:VALUE GENERAL, "Include Complete Application
Configuration”, "False"

It sets the "Include Complete Application Configuration” as "False”.

TEKEXP:VALUE? GENERAL, "Include Complete Application
Configuration”

It returns the "True" or "False".

TEKEXP:VALUE? GENERAL, "Include User Comments"

It returns the "True" or "False".

TEKEXP:VALUE GENERAL, "Include User Comments", "False"

It sets the "Include User Comments" as "False".

TEKEXP:VALUE? GENERAL, "View Report After Generating"

It returns the "True" or "False".

TEKEXP:VALUE GENERAL, "View Report After Generating", "True"

It sets the "View Report After Generating" as "True".

TEKEXP:STATE?

Its returns the current state.

TEKEXP:STATE RUN Its push the RUN button.

TEKEXP:LASTERROR? It returns "TEKEXP:INSTRUMENT? "Real Time Scope?" - "ERROR:
INSTRUMENT_NOT_FOUND", when no instrument is found.

TEKEXP:EXPORT REPORT\n It returns the report file in bytes. This can be written into another file

for further analysis.

TEKEXP:EXPORT IMAGE,"ImageA.png"\n

It returns the image file in bytes. This can be written into another file
for further analysis.

TEKEXP:EXPORT WFM,"WaveformA.wfm"\n

It returns the waveform file in bytes. This can be written into another
file for further analysis.

TEKEXP:INFO? REPORT\n

It returns “100,’ReportFileName.mht™, when 100 is the filesize in
bytes for the filename ReportFileName.
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Example

Description

TEKEXP:INFO? WFM\n

It returns “100,“WfmFileName1.wfm™;*200, " WfmFileName2.wfm™
when 100 is the filesize in bytes for the filename
WfmFileName1.wfm and 200 is the filesize in bytes for the filename
WfmFileName2.wfm.

TEKEXP:INFO? IMAGE

It returns the image file name.

TEKEXP:POPUP “OK"\n

It sets OK as the response to active popup in the application.

TEKEXP:POPUP?\n

It returns "OK", when OK is the active popup information shown in
the application.

TEKEXP:REPORT GENERATE\n

It generates report for the current session.

TEKEXP:REPORT? “Scope Information™\n

It returns "DPO73304SX" when DPO73304SX is the scope model.
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10G-KR protocol decoding

This solution supports KR Protocol Decode for the 64b-66b standard as defined
in IEEE802.3.

NOTE. KR protocol decoding is supported only on C and DX series oscilloscopes
with the Windows 7 (64-bit) operating system.

To decode KR protocol signals:

1. Connect the test setup and acquire a valid signal with the instrument.

Digital Oscilloscope

DuUT

1€ I 8 ——— .Fﬂ:—;ﬁ.‘{\ AL,
P7520 Probe 0279001

2. Select Vertical > Bus Setup (or Digital > Bus Setup on MSO70K series
oscilloscopes) to open the Bus Setup controls.

File | Edit | “ettical | Digital | Horiziteg | Trig | Displ

Digital Setup...

Bus Setup. ..
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3. Click Config tab to open the Bus Setup pane.

Bus Setup
il Bus 1
B1 f @
B2 | Clear Bus
B3
B4
B Lo
= [ B1
57 " Bus1Position
1 0.0div

Bus Type _
+ Serfal Custom

KR

Custom v |
KR_Descrambler

Parallel :
Components

Data

5. Select Custom Decoder option:

= KR: Without descrambler

Click Serial and select Custom from the list.

= KR Descrambler: With descambler support

Enter a decoder Threshold value based on the incoming signal.

Click Bus 1 On. The oscilloscope screen displays the decoded packets.

09150 110101 1011 100 10010 00T IO

AT 200mV 1.0ps  -27.
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Click the Display tab to optionally select Busform and Waveform. The

Protocol Decode Event Table shows the list of decoded packets. You can also
access the Protocol Decode Event Table from the TekScope Analyze menu.

Protocol Decode Event Table
B1 |

D0/p1/D2/D3/D4/T5/C6/CT

| Doh

ooh ooh pboh poh

n

3sh 5ph

o Jndex,_stort e _Sync_i. Syve Block_Yype Iny_lock_Type_Cata Contrt
1072 [-29.23u [2h TO/€1/€2/C3/C4/C5/CB/CT - - 22h 11h 08h 44h 22h 11F -
1073(-29.17u Oh 999999999999999%h
1074 (-29.10u |2h D0/D1/T2/C3/C4/C5/C6/CT |aah aah 2ah /k/ 2ah /k/ 2ah
1075|-29.03u_|2h D0/D1,/D2/T3/C4/C5/C6/CT 88h EBh EBh 5ph 6eh 77h 3sh
1076|-28.97u_|2h D0/D1/D2/D3/T4/C5/C6/C7 |cch ¢ch cch cch R1 19h 4ch
1077 [-28.90u |2h D0/p1/D2/D3/D4/T5/C6/C7 |poh _poh poh poh poh 3sh 5ph
1078 |-28.84u_|2h D0/D1,/D2/D3,/D4/D5/T6/C7 EEh EEh EEh EEh EEh EEh 6Eh
1079|-28.77u [2h 00/01/D2/D3/D4/D5/06/T7 FFh FFh FFh FFh FFh FFh FFh
1080 |-28.70u_|2h co/c1/c2/c3/ca/cs/ce/cT | 08h 44h 22h 11h 08h 4aF
1081 |-28,64u_|2h C0/c1/c2/c3/04/D5/06/07 02h 22h 22h 11h 08h 42h 22h
(1082 |-28.57u oh 13333333333333333h
1083 |-28.51u |2h 00/01/D2/D3/54,/D5/D6/D7 |44h 44h 44h 44h 44h 44h
1084 |-28.44u |2h 00/D1/D2/D3/04/D5/D6/D7 |55h 55h 55h 55h 55h 55h
1085 [-28. 37u 3h
1086 |-28.31u |2h 00/D1/D2/D3/C4/C5/C6/C7 77h 77h 77h 38h 5ph 6Eh 77h
1087 [-28.24u_|2h TO/C1/€2/C3/C4/C5/C6/CT | 22h 11h 08h 44h 22h 11F

| |1088|-28.18u 0h 999999999999999%h
1089 [-28.11u |2h DO0/D1/T2/C3/CA/C5/C6/CT (Ash Aah 2Ah /K/ 2Ah /K/ 2Ah
1090 (-28.04u |2h D0/D1/D2/T3/C4/C5/CE/CT |86h Bsh BBh 5oh 6eh 77h 3sh

| |1091|-27.98u [2h D0/D1/D2/D3/T4/C5/C6/CT cch cch cch cch R1 19h 4Ch
1092|-27.91u [2h D0/D1,/02/D3/D4/T5/€6/C7 ooh poh ooh boh DDh 38h 50h
1093 |-27.85u |2h D0/D1/D2/D3/D4/D5/T6/C7 |EEh EEh EEh EEh EEh EER 6Eh
1094 (-27.78u |2h p0/p1/D2/D3/D4/D5/D6/T7 Frh FFh FFh FFh FFh FFh FFh

| _[1095|-27.71u |2h c0/c1/c2/c3/c4/C5/C6/C7 08h 44h 22h 11h 08h 44t
1096 |-27.65u |2h C0/c1/c2/C3/04/D5/06/D7 |02h 22h 22h 11h 08h 44h 22h
1097 -27. 58u oh 13333333333333333h
1098 |-27.52u |2h 00/D1/D2/D3/54/D5/D6/D7 44h 44h 44h 4ah 44h 44h
1099|-27.45u [2h 00/p1/D2/D3/04/D5/06/D7 55h 55h 55h 55h 55h 55h
1100 (-27.38u 3h | 7866666666666666h

[ |1101]-27.32u |2h 00/01,/D2/D3/C4,/C5/C6/C7 77h 77h 77h 38h 50h 6Eh 77h
11102 -27. 25u_|2h |T0/C1/€2/C3/Ca/C5/CH/CT| 1 122h 11h 08h 44h 22h 11k
1103 [-27.19u oh 19999999999999990h
1104 -27.12u |2h D0/D1/T2/C3/C4/C5/C6/CT |Aah Aah 2ah /k/ 2ah /k/ 2ah
1105 (-27.05u [2h D0/D1/D2/T3/C4/C5/C6/CT 88h BEh BBh 50h 6eh 77h 38h
1106|-26.99u_|2h D0/D1/D2/D3/T4/C5/C6/C7 |cch cch cch cch Rl 19h 4ch
1107 [-26.92u_|2h

9. Click Export to save the packet information to a .csv format file.

10. Select Analyze > Search in the TekScope application to enable searching on
the various packet fields.

Search...

hark...

Pratocal Dec
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11. Click on Bus in the Type field.

—Search - Select

Select Glitch Width SetupHold

Configure

ERINCTENCEE O]
-1 @]

Results Window

Bus Runt

Transition Timeout

12. Click the Configure tab and select the packet type to search for from the
Search For list.

=
[F1 v [ ot cunn ) | T ﬂ

Im_Sync

Block_Type
) 0_Code

Inv_O_Code

13. Select Data in the Search For list to search on the specific data fields.

Search - Configure

[+]
paa |V}
Configure

Results

Select
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14. Use the Radix and Data fields to specify the data for which to search. The
application highlights the search results on the instrument graticule.

] : BBh:Data BBh:Data BBh:Data [Bh:/T/| 5Dh:C  6Eh: Control77h: Control| 3Bh.¢ &

&» 200mVidiv 500 Bi:12.56 \ Ee» S 4omv 20.0ps/div 50.0GS/s 20.0psipt

@7 200mY 10.0ns -40.8ps -40.7ps Preview Single Seq

0 acgs RL:10.0M

Man  November 22, 2012 04:00:32

15. Click the Results tab to show the list of search results.

Results: Mark Table

Index Type Source | Location Time Dela D
sec | ms | us | ns | ps
7! Bus B1:Custom |-41.749us| 000 000 000 007 999 Data B
] Bus B1: Custorn |-41.741us| 000 000 000 008 000 Data
Z1 8 Bus B1: Custorn |-40.767us| 00 00 000 874 000 Data
82 Bus B1. Custom |-40.759us| 00 00 000 007 939 Dala
83 Hus B1: Custom |-40.751us| 00 00 000 002 000 Diata
184 Hus B1: Custom |-38.777us| 00 00000 874 002 Data hd
AZ1.22
User Marks in Table AZ273 Total Marks:
AZ1.73

G G
G Gd) G o

16. Click on items in the list to display the associated waveform on the
instrument graticule.

] : BBh:Data BBh:Data BBh:Data [Bh:fT/| 6Dh:C  6Eh: Control77h: Control| 3Bh-¢f §

&P 200mVidiv 500 By12.56 \ Ee® S 40mv 20.0ps/div 50.0GS/s 20.0psipt
@ 200mV 10.0ns  -40.8ps -40.7ps

Preview Single Seq

0 acgs RL:10.0M

Man  November 22, 2012 04:00:59

17. Click Export to save the search results to a .csv format file.
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Parameters

About application
parameters

Setup panel configuration
parameters

&4

This section describes the 10G-KR application parameters, and includes the

default menu settings.

The parameters for the menus, and options list the selections available for each

and include the default values.

DUT tab parameters.
Parameters Selection Default Setting
DUTID DUT001
Waveform Acquire live waveforms,| Acquire live waveforms
Use pre-recorded
waveform files
View Compliance, Advanced | Compliance
DUT Type 10GBase-KR, 10GBase-KR
40GBase-KR
Number of Lanes to Test 1 Lane, 2 Lanes, 1 Lane
4 Lanes
Selected Test Lanes Lane0, Lane1, Lane2, |Lane0

Lane3
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Test Selection tab parameter:

S.

Parameters

Selection

Default Setting

10 GBase-KR-IEEE 802.3ap,
40G Base-KR4-IEEE 802.3ba

Signaling speed

= Differential peak-to-peak
output voltage (max)

= Differential peak-to-peak
output voltage (max) with
Tx disabled

= Common mode voltage
limits
= Transition time

= Max output jitter (peak-
peak)

= Transmitter output
waveform characteristics

= QOutput waveform

All measurements selected

coefficient update
= QOutput waveform
coefficient status
Acquisitions tab parameters.
Parameters Selection Default Setting

Acquisition and Save Options

= Save All Waveforms
Before Analysis

= Analyze Immediately, No
Waveforms Saved

= Save and Analyze
Acquisition In Sequence

Save All Waveforms Before
Analysis

Show Acquire Parameters

Select, De-select

De-select

Signal Validation

= Prompt me if signal fails
= Skip test if signal fails

= Use signal as is - Don't
Check

Prompt me if signal fails

TekExpress® 10G-KR Printable Application Help
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Configuration tab parameters.

Table 24: Global settings parameters

Parameters

Selection

Default Setting

Mode

Compliance Mode, User
Defined Mode

Compliance Mode

Global Settings

Sample Rate (GS/s) 50 50

Record Length (M) 5,10 5

Pattern Type PRBS7,9, 11, 15, 20, 23,31 | PRBS11

Analysis Option Analyze without de-embedding

= Analyze without de-
embedding filter

= Analyze with de-
embedding filter

= Analyze with and without
de-embedding filter

filter

Table 25: Measurement settings parameters

Parameters Selection Default Setting
Signaling speed | Acquire Signal Type PRBS7, 9, 11, 15, | PRBS7
Differential peak- | Acquire Signal Type 20,23, 31 PRBS11
to-peak output

voltage (max)

Differential peak- | Acquire Signal Type PRBS11
to-peak output

voltage (max) with

Tx disabled

Common mode | Acquire Signal Type PRBS11

voltage limits

Transition time | Acquire

Signal Type N1NO

N1NO

Max output jitter | Acquire

Signal Type PRBS7, 9, 11, 15, | PRBS11

(peak-peak) 20, 23, 31

RiDj Target BER (1e-) |10, 12 12
Transmitter output | Acquire Signal Type NINO NINO
waveform
characteristics
Output waveform | Acquire Signal Type N1NO N1NO
coefficient update
Output waveform | Acquire Signal Type N1NO N1NO

coefficient status
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Reports panel parameters | Parameters

Selection

Default Setting

Report name

X:\10G-KR\Reports
\DUTO001.mht

Save as Type

PDF (*.pdf;), Web Archive
(*.mht; *.mhtml), CSV (*.csv;)

Web Archive (*.mht; *.mhtml)
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10G-KR measurements Compliance mode, 21

72.6.5 Differential peak-to-peak output voltage Configuration tab, 20
(max) with Tx disabled, 40 Configuration tab parameter
72.7.1.10 Transmitter output waveform instruments detected, 24
characteristics, 44 Configuration tab parameters

72.7.1.11a Output waveform coefficient update, globgl settings, 24. )
45 Configuring email notifications, 19

72.7.1.11b Output waveform coefficient status, 46 Connected' instruments
72.7.1.3 Signaling speed, 39 scarching for, 17, 13

137 1.4 Differential veak.t K outout volt Connection requirements, 35
.7.1.4 Differential peak-to-peak output voltage Crosstalk source, 21

(max), 39
72.7.1.7 Transition time, 42
72.7.1.8 Max output jitter (peak-peak), 43 D
Common mode voltage deviation during LPI Data rate, 21
taods, 45 » DUT ID, 21
Common mode voltage limits, 41 DUT parameter

400G-TXE features, v

A

About application parameters, 84 E
About TekExpress, v
Acquire live waveforms, 21

user comments, 21
DUT-instrument setup, 35

Email notifications, 19

i Equi t setup, 35
Acquire parameters quipment setup

including in test reports, 31 Extensions, file names, 9
viewing in reports, 33
Acquisition tab, 23 F

Analysis options, 26
Ha’ys1s OpHons, Features (400G-TXE), v

Application directories, 8 . .
File name extensions, 9

Application panels overview, 12

Application version (show), 7 G
B GPIB, 17
Button

calibration, 23 H

clear log, 27

Help conventions, 1
save, 27 p

C |

Calibration button, 23 Installing the software
switch matrix application, 7

C d butt 14
Ommand butons, Instrument-DUT setup, 35

Compensate the signal path, 36
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Instruments
discovering connected, 17

viewing connected, 18
Instruments and accessories required, 6

Instruments detected, 24

K

Keep on top, 11

L

LAN, 17
License agreement (show), 7
Log view

save file, 27

Menus
Options, 16
Minimum system requirements, 5

My TekExpress folder
files stored in, 30

N

Names, file extensions, 9
Non-VISA, 17

o)

OIF-CEI-56-VSR, v
OIF-CEI-56G-LR, v
OIF-CEI-56G-MR, v
OIF-PAM4 standard, 21

Options menu
Instrument control settings, 17

keep on top, 11
Oscilloscope compensation, 36

P

Panels, 12
Preferences menu, 29
Preferences tab

90

send an email, 26
setup panel, 26

R

Related documentation, 2
Report contents, 34
Report name, 32

Report options, 31
Report sections, 33

Reports
receiving in email notifications, 19
Reports panel, 12, 30

Resource file, 11

Results panel
summary of test results, 29

test name, 29
Running tests, 38

S

Save log file, 27
Saving tests, 30
Schematic button (DUT-instrument setup), 35

SCPI commands
Command parameters list, 69

Examples, 75

TEKEXP:*IDN?, 55
TEKEXP:*OPC?, 55
TEKEXP:ACQUIRE MODE, 56
TEKEXP:ACQUIRE _MODE?, 56
TEKEXP:EXPORT, 57
TEKEXP:INFO?, 57
TEKEXP:INSTRUMENT, 58
TEKEXP:INSTRUMENT?, 58
TEKEXP:LASTERROR?, 59
TEKEXP:LIST?, 59
TEKEXP:MODE, 60
TEKEXP:MODE?, 61
TEKEXP:POPUP, 61
TEKEXP:POPUP?, 62
TEKEXP:REPORT, 62
TEKEXP:REPORT?, 63
TEKEXP:RESULT?, 63
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TEKEXP:SELECT, 64
TEKEXP:SELECT?, 65
TEKEXP:SETUP, 65
TEKEXP:STATE, 66
TEKEXP:STATE?, 66
TEKEXP:VALUE, 67

TEKEXP:VALUE?, 68
Selecting test report contents, 31

Selecting tests, 22
Serial, 17
Session folders and files, 30
Setting up equipment, 35
Setup

acquisition tab, 23
Setup panel

DUT parameter, 20

preferences tab, 20

test selection, 20
Show acquire parameters, 23

Software installation
switch matrix application, 7
Specification
OIF-CEI-56G-LR, 21
OIF-CEI-56G-MR, 21
OIF-CEI-56G-VSR, 21
Status panel
log view, 27
message history, 27
test status tab, 27
Support, 2
System requirements, 5

T

Technical support, 2
Tek Link, 17
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Test Name, 23
Test reports, 33

Test results
emailing, 19

Test selection
400G-TXE, 22

test description, 22
Test selection controls, 22

Test setup files, 30

Test status
acquire status, 27

analysis status, 27

auto scroll, 27
Test-related files, 30

Tests
running, 38

U

USB, 17
Use pre-recorded waveforms, 21

User Comments
including in reports, 33
User defined mode, 21

vV

View a report, 33

View application license agreement, 7
View application software version, 7
VXI, 17

W

Waveform files
locating and storing, 30
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